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Features ContentFeatures Content

Thank you for selecting the Fuji Xerox DocuCentre-II 3005/2055/2005. 

This quick user guide provides the fundamental Copy / Fax / Scan

 

/ Print operating 
procedures for ease use of the machine. 

Quick User Guide OrganizationQuick User Guide Organization

♣ Features Content ………………………………………………

 

Page 01 -

 

02
Describes the content of this guide and overview of the machine.

♣ Copy ……………………………………………………………. Page 03 -

 

13
Describes the copy features and operations.

♣ Fax ………….……………………………………………….…..

 

Page 14 -

 

19
Describes the fax features and operations. 

♣ Scan …………………………….………….……………………

 

Page 20 -

 

25
Describes the scan features and operations.

♣ Print …………………………….……………………………….  Page 26 -

 

33
Describes the print features and operations from computer. 

♣ Paper Jams …………………………….…….….………………  Page 34 -

 

36
Describes procedures to clear paper jams when error message

 

displays.  

♣ Consumables …………………………….…….….……………  Page 37 -

 

40
Describes procedures to replace consumables 
(Toners/Drum/Staples)

♣ Online Support Assistance ………….…….….………………  Page 41 -

 

42
Describes measures to acquire online help solutions 
and / or submit a Service & Support Request online. 

IMPORTANT :

The screen images in this guide solely used for illustration and

 

are based on the standard machine 
configurations. Some features mentioned may not be used depending on the machine

 

 
configurations. Unsupported features will not be displayed on the screen. Abnormal features will 
be grayed out on the screen. 

This Quick User Guide may not be copied or modified without the written consent of the 
publisher. 
Parts of this user guide are subject to change without prior notice.
We welcome any comments on ambiguities, errors, omissions or missing pages.

Contact Fuji Xerox Customer Training Department for more information. 
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OverviewOverview

Powering On / Off the machine

Power Switch
Turn ON 
Machine

Turn OFF  
machine

Power Saver button 
-Press to exit power 
saver mode. 

Log In/Out button 
-Press to enter User 
ID & Passcode

To Login to User Account, press Log In/Out button & enter user details 
as follow. ( Note: Press Log In/Out button again to Logout. )
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COPY FEATURESCOPY FEATURES

Reduce/Enlarge Page 04

To make a reduced or an enlarge output 
size.

2-Sided Copying   Page 05

To make copies single or double sided output.

Book Copying Page 06

To copy bound documents using platen 
glass on to 2 separate sheets

Mixed Sized Originals Page 07

To scan different size documents  
simultaneously and copies onto matching  
paper size.

A
3

A
4

A 
5

A
3

A
4

A 
5

Copy Output / Sorting Page 09

To make copies collated (stapled & punched)

Multiple-Up Page 08

To copy multiple documents onto a single 
sheet of paper

Edge Erase / Image Shift Page 10

To erase unwanted marks along the edges / 
To shift image copy position
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Booklet Creation Page 11

To copy multiple sheets of documents in  
page order to make a booklet

ID Card Copying* Page 13

To copy both sides of ID card onto one side 
of paper

Repeat Image Page 12

Image to be print repeatedly on one sheet of 
paper

[Before] 

[After] 

[Uncollated]
1,1...2,2...3,3...

[Collated]
1,2,3…1,2.3…



Making reduced or enlarged copies from the original 

1 Select [Copy]

2 Select [Reduce / 
Enlarge] for desired 
ratio; select [More] for 
other presets. 

3 Select [Paper Supply] for 
tray selection. 

4 Enter number of copies 
(1 to 999) using numeric 
keypad.

5 Press <Start> button

You can make copies with scaling by selecting desired copy size ratio.

Original A4 Output A3

User Guide P.58
Note
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1 Select [Copy]

2 Select [Copy] tab
Select [2-Sided Copying]

3 Select an option and 
select [Save]
1 1 Sided copy 1-sided 
document onto 1 side of paper 
1 2 Sided copy 1-sided 
document onto 2 sides of paper 
2 2 Sided copy 2-sided 
document onto 2 sides of paper
2 1Sided copy 2-sided 
document on 1 side of the paper

4 Enter number of copies 
(1 to 999) using numeric 
keypad.

5 Press <Start> button

Making copies Single Sided / Double Sided

You can make copies and output as single-sided / double-sided. 

Head to Head – both sides of the 
paper are at the same orientation.
Head to Toe – one side of the paper 
are at rotated orientation

Note

C
op

y

User Guide P.62
Note

0505



You can make copies from bound document into separate sheets of 
paper using platen glass.

1 Select [Copy]

2 Select [Layout 
Adjustment] tab – Choose 
[Book Copying]

3 Select an option and 
Select [Save];
Left Page then Right 
Right Page then Left
Top Page then Bottom 
Select Both Pages (for 
scanning left & right page)

4

 

Press <Start> button

Both Pages – to copy both 
pages of the book 
Left Only/Right Only – copy 
selected side of the book

Note

Making a copy from a bound document (Book Copying) 
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You can make copy of different sizes documents and copies onto 
matching paper size.

1 Select [Copy]

2 Select [Layout 
Adjustment] tab Select 
[Mixed Sized Originals] 
and Select [ON]

3

 

Select “Auto%” on 
[General Settings] and 
Select Paper Size required. 
[Auto Paper Tray]

4 Select [Save] and Press 
<Start> button

Making copy of different sized document (Mixed Size)
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1 Select [Copy]

2 Select [Output Format] 
tab 

3 Select [Multiple-Up] 
1 Page Up - Multiple Up is 
not applied.
2 Pages Up – 2 documents 
copied into 1 sheet of paper
4 Pages Up – 4 documents 
copied into 1 sheet of paper
8 Pages Up – 8 documents 
copied into 1 sheet of paper

4

 

Select ‘Reading Order’ 
for document layout and 
Press <Start> button

You can make copies from multiple sheets of documents onto single 
sheet of paper using Multiple-Up. 

Making copy of multiple sheets onto 1 sheet paper

[Auto %] is automatically  
selected to make copies fit 
into paper selection. 

Note
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To make copies output collated. Output can be stapled / hole punched. 

1 Select [Copy]

2 Select [Copy] tab and 
select [Copy Output]

3 Select [Collated], and 
select Finishing (if 
available). Select Staple 
/ Punch Positions, 
Select [Save] 

4

 

Enter number of sets 
using numeric keypad 
and press <Start> 
button

Collated - arranged in page 
order per sets.
Uncollated - arranged in total 
copies and sort sheets by page

Note

Making multiple copies from the original [sorting] 

[Uncollated] 1,1...2,2...3,3... [Finishing] 
Stapled / Hole Punch

[Collated] 1,2,3…1,2.3…
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1 Select [Copy]

2 Select [Layout 
Adjustment] tab; Select 
Edge Erase or Image 
Shift (where applicable)

3 Edge Erase – set area to 
erase using arrow keys at 
1mm increments each.
Image Shift – set margin 
to shift using arrow keys 
at 1mm increments each. 
Select [Save]

4

 

Enter number of sets 
using numeric keypad 
and Press <Start> button

To make copies with edge erased / image shifted

Making copies with edge erased / image shifted

C
op

y

User Guide P.70-71
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1 Select [Copy]

2 Select [Output Format] 
tab 

3 Select [Booklet 
Creation] and choose 
option “On - Create 
Booklet” or “On - Right 
Bind Create Booklet” 
and Select [Save]
Optional:
Finishing (Folding + Stapling)

4 Select [Save] and 
Press <Start> button

Printed Covers The first  
page of the document is 
copied on the cover

Note

Making a copy into a booklet format (Booklet Creation)

You can make copies from multiple sheets of documents onto both 
sides of the paper in page order to make a booklet

Optional feature: 
Folding & Staple

54321
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Make copy of a document / image onto 1 sheet of paper repeatedly. 

Making an image printed repeatedly (Repeat Image) 

1 Select [Copy]

2 Select [Output Format] 
tab. Select [Repeat 
Image]
1 Page Up – Image no t 
repeated 
Auto Repeat – Auto repeat 
according to original  
document size, paper size 
and copy ratio.
Variable Repeat – Use  r 
defined number of times to 
repeat copy image
Select [Save]

3

 

Select [Layout Adjustment] 
tab – Select Original Size to 
enter width (X) & height (Y) at 
1mm increments -
Select [Save]

4 Press <Start> button

C
op

y

User Guide P.82 Repeat Image
User Guide P.68 Original Size

Note

1212



1 Select [Copy]

2 Select [Output Format] [2] 
ID Card Copying. Select 
ON – Select [Save]

3 Load ID Card on the top 
left of the platen glass. 
Close document cover 
and press <Start>

4 Open document cover 
and turn to the 2nd side. 
Place it on the same place 
and press <Start>

5 The ID Card will then be 
printed.

To make copy of ID card both sides on the same page of paper

Making copies of ID Card 
C

op
y

User Guide P.89
Note
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Numeric Keypads Page 15

To fax document using numeric keypads to a 
specific location 

2-Sided Originals Page 17

To enable scan both sides of a document 
then transmits automatically 

1-Sided: Scans 1-sided documents to  
transmit.
2-Sided (H to T): Scans 2-sided (head to 
toe) documents to transmit.
2-Sided (H to H): Scans 2-sided (head to 
head) documents to transmit.

Transmission Report   Page 18

To print a transmission report automatically 
after each fax complete successfully /  
unsuccessfully 

Transmission Report–

01  78822984  12:45 CP

ASDFG
EWTEt
dfrewtry

Broadcast Send Page 15

To fax document to multiple locations. 

Cancel Fax Job 

To cancel a fax job, press [Job Status] button. 
Select fax job and press [Stop] / [cancel].  

FAX FEATURESFAX FEATURES

Speed Dial/One Touch Page 15

To fax document using Speed Dial/One  
Touch Dial  

Fa
x
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Address Book/Index Page 16

To fax documents using pre-registered  
numbers from the address book 

On-Hook Dialing Page 15

Use this feature to send or receive fax 
manually. Select {Manual Send} to send or 
[Exit (Line Cut)] to exit on-hook 



You can select fax feature on [Fax] screen to send document to single 
or multiple recipient(s). 

Fax transmission to a single / multiple location(s) 

1 Select [Fax]

2 Enter recipient(s) fax 
number using numeric 
keypad. 

3 Select [Next Recipient] 
button to enter multiple 
recipients’ fax number.

4

 

If multiple location fax 
is programmed, select 
[Yes] on confirmation 
screen to start fax 
transmission

5 Press the <Start> button

Fa
x

User Guide P.117
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Making a fax transmission using Address Book Entries

You can specify fax recipients from pre-registered Address Book

1 Select [Fax]

2 Select [Address Book] 
button to select 
recipients from the 
registered entries. 

3 Select [ABC] [DEF] 
button to search 
Recipients by Index 
Search.  

4

 

Or select recipients’ fax 
number from the One 
Touch Dial (001 – 070) 
or using Numeric 
Keypad

5 Press the <Start> button

Fa
x

User Guide P.118
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Making a 2-sided fax transmission

You can scan a 2 sided document and send in a single operation. 

1 Select [Fax]

2 Select [Address Book] 
button to select recipients 
or enter Fax number using 
Numeric Keypad

3 Or select recipients’ fax 
number from the One 
Touch Dial (001 – 070).

4 Select 2 Sided Originals 
- 2 Sided (Head to Head) or
- 2 Sided (Head to Toe)

5 Press the <Start> button.

Recipients’ fax number will be 
displayed on the Address list

Note

Fa
x
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Making a fax with a transmission report printed

Fax transmission results can be printed automatically after each fax 
transmission. 

1 Select [Fax]

2 Select [Transmission 
Options] tab – Select 
Transmission Report 

3 On the Transmission 
Report Screen, Select 
“ON” 

4

 

Select [Address Book] 
button to select recipients 
or enter Fax number using 
Numeric Keypad

5 Press the <Start> button.

Fa
x
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To register Fax Address and Group Send

To store Fax addresses in the address book [up to 500 entries]

To Register Fax 
Address

1 All Services screen

2 Select [Setup Menu] - Select 
[Address Book]

3 Select an address e.g. 001 (not 
in use) - Press [Create/Delete]

4 Address Type: Select [Change 
Settings] Select - FAX – Save -

5 Fax Number: Select [Change 
Settings] enter recipient fax no.

6 Recipient Name: Select [Change 
Settings] Enter Recipient’s 
Name / Company Name

7 Index: Select [Change Settings] 
Enter 1 alphanumeric character 
(e.g. Fuji Xerox = F)

8 Save and Close; Repeat steps 3- 
7 to continue or Press [Close] to 
Exit Setup Menu. 

To Group Pre-

 

Registered Fax 
Address

1 All Services screen

2 Select [Setup Menu] – Select 
[Group Send]

3 Select any group no. (e.g #01) 
and press [Create/Delete]

4 Enter the pre-registered 
address no. by using numeric 
keypads (e.g. 001) Press [ADD]  

5 Repeat step 4 to continue 
registering fax no. to the same 
group

6 Select [Save] and Close to Exit 
[Setup Menu].

Max 50 Groups can be created
Max 20 Fax Addresses per group 

Fa
x

User Guide P.343
Note

User Guide P.349
Note
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To scan documents and send the data to a 
computer on the network.

Book Scanning Page 25

The feature scans a bounded documents onto 
separate sheets of paper using platen glass.

File Name           Page 25

The default file name is "img-xxx-yyy.zzz" 
(where xxx is the date and time, yyy is the 
page number, and zzz is the extension).

Sc
an

Scan to Mailbox               Page 21

To scan documents and save the scanned 
data to a mailbox located at the machine.

SCAN FEATURESSCAN FEATURES

Mailbox

Scan to PC [SMB] Page 24Scan to Email Page 23

To scan documents and send the scanned 
data as an e-mail attachment

Resolution (dpi) Page 24

Set scanning color & output resolution for the 
documents (up to 600dpi). 

2020

You can import scanned data to your  
computer using Mailbox Viewer program. 

Importing Mailbox data Page 22

Mailbox

Document can be scanned to the supported 
format. [JPEG, TIFF, PDF, DW]

Output Format * Page 25



1 Select [Scan to Mailbox]

2 Select required mailbox. 
* Enter password if any

3 Select ‘2 Sided Original’ if 
necessary. 

4 On the [Layout 
Adjustment] tab, select 
‘Scan Resolution’ if 
necessary.

5 Press the <Start> button. 
Documents are scanned 
and stored at the selected 
mailbox.

You can scan and save the scanned data to a pre-registered mailbox 
and import to the computer using Mailbox Viewer application.

Sc
an

To Scan document to Mailbox

Mailbox

User Guide P.180
Note
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1 From computer, Select 
[Start] > All Programs > 
Fuji Xerox > Network 
Scanner Utility2 > Mailbox 
Viewer2  

2 Select required scanner;
* e.g. DocuCentre-II 3005 
(192.168.12.14) – Click 
[Select Scanner] button

3 Enter Mailbox No and 
Password - Click [Open 
Mailbox] button 

4 Select required file and 
click [Import] to computer. 
Default file location at 
C:\My Document\Fuji 
Xerox\Network Scan\

You can import scanned documents / data from mailbox to the 
computer using mailbox viewer program. 

Sc
an

To Import Mailbox data into personal computer

Mailbox

User Guide P.239
Note
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You can scan & send the scanned data to selected recipients as e-mail 
attachment(s). 

1 Select [Email]

2 Select [Address Book] or 
use [Keyboard] to enter 
email address(s)

3 Select ‘2 Sided Originals’ 
and ‘File Format’ if 
necessary.

4 Select [Layout Adjustment] 
tab - ‘Scan Resolution’ if 
necessary.

5 On the [Output Format] tab, 
select ‘File Name’ or ‘Split 
Send’ if necessary.
Press the <Start> button. 

Sc
an

To Scan document and transfer via Email

User Guide P.174
Note
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You can scan and transfer the scanned documents to a computer 
on the network. 

1 Select [Scan to PC]

2 Select [Address Book] or 
select [Browse] to search 
location

3 Select ‘2 Sided Originals’ 
and ‘File Format’ if 
necessary. 

4 Select [Layout Adjustment] 
tab - ‘Scan Resolution’ if 
necessary.

5 On the [Output Format] tab, 
select ‘File Name’.
Press the <Start> button. 

Sc
an

To Scan document and transfer to PC (SMB)

User Guide P.182
Note
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1 Select preferred scan 
method e.g. Scan to PC 

2 Select File Format (e.g. PDF) 
[Layout Adjustment] tab – 
Choose [Book Scanning]

3 Select an option and Select 
[Save];
Left Page then Right 
Right Page then Left
Top Page then Bottom 
Select Both Pages (for scanning 
left & right page)

4 Select [Original Size] to 
enter document size or 
select from the Presets. 

5 On the [Output Format] tab, 
select ‘File Name’. Press the 
<Start> button. 

Book Scanning allows you to scan a book onto separate sheets of paper 
in page order and transfer via any scanning method [Mailbox/Email/SMB]

Sc
an

To scan a bound document (Book Scanning) 

User Guide P.195
Note
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To send files and fax directly from computer 
without printing out hardcopies. 

Pr
in

t

PRINTING FEATURESPRINTING FEATURES

Printing Job Types Page 27

Normal Print – prints as normal print
Secure Print – stores print jobs on the  
machine and prints when UserID & password 
entered 
Sample Set – prints a trial copy 
Delayed Print – Temporarily stores print 
jobs on the machine to print it at specified 
time.
Save to Mailbox – stores print job at 
registered mailbox and print upon required.
Fax – PC Faxing.

PC Faxing Page 33

Secure Print Page 28

Temporarily stores print jobs on the machine 
and prints when UserID & password entered.

2626

To print multi-page file into a booklet format 
and double sided.

Booklet Printing Page 30

To print files with a pre-fixed text such as 
‘Urgent’ or ‘Confidential’ over the printout. 

Watermarks Page 32

To print multi-page files onto single sheet of 
paper [from 2 Up and up to 32 Up]

Multiple Up Printing Page 31

To specify paper tray for printing. Optional: 
Finishing Stapled / Hole Punched.

Default Paper Tray  - Auto Tray Select
If Tray 5 [Bypass] is selected, paper type 
can be specified according to paper loaded 
on Tray 5.
Default Finishing Output – Collated
If Finishing is selected, hole punching and 
stapling can be applied to the printed copies. 

Paper Tray Selection Page 27

You can send file and prints on both sides of 
paper. 

2 Sided Printing Page 29



From your application, you can print directly from computer.

1 From application, Select 
Printer – [Properties]

2 On the [Paper/Output] tab, 
select <Paper Summary> 
to select required paper 
tray. Click [OK]

3 Select [Layout] tab <Fit to 
New Paper Size> or 
<Variable Reduce/Enlarge> 
for reduce/enlarge print 
image(s)

4 Select [OK] on all open 
windows to print. 

Pr
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Allows to set a password to a print job and temporarily stores print 
memory on the machine, and print upon entering  password. 

1 From application, Select 
Printer – [Properties]

2 On the [Paper/Output] tab, 
select <Job Type> Secure 
Print - click <Setup> to enter 
User ID & Passcode. Click 
[OK] on all open window.

3

 

From machine, Press [Job 
Status] button - Select 
<Stored Documents> tab. 
Select [Secure Print]

4

 

Select UserID - [Document 
List] button. Enter Passcode 
and press Confirm. 

5 Select file and select [Print] 
A message displayed – 
Select your preference – the 
job will be printed.

Pr
in
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1 From application, Select 
Printer – [Properties]

2 On the [Paper/Output] tab, 
select <2 Sided Print>
- 2 Sided Print  
- 2 Sided Flip on Short 
Edge

3 *Optional Feature
Select <Stapling> to enable 
Stapling. Set required 
stapling position.

4 Select [OK] on all open 
windows to print

Making a 2-sided print (optional - Finishing) 

Files can be printed into 2 sided format with 2 sided flip on long edge or 
flip on short edge. 

Pr
in
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Making a booklet print from computer 

Booklet printing enables multi-page files printed 2-sided booklet format 
arranged in ascending order, and fold to form a booklet. 

1 From application, Select 
Printer – [Properties]

2 On the [Layout] tab, select 
<Booklet/Poster/Mixed 
Document>. 
Select Booklet Creation
Choose Binding [Left / Right]
* Optional: Fold & Staple
Select [OK]

3

 

A popup window displays 
the changes. Select [OK]

4 Select ‘Fit to New Paper 
Size’ – Set any preferred 
paper size or select A4 
(210mm x 297mm) 

5 Select [OK] on all open 
windows to print.

Pr
in
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Prints multi pages in single sheet of paper

1 From application, Select 
Printer – [Properties] 

2 On the [Layout] tab, select 
<Multiple-Up>
Choose from 1 Page Up to 32 
Pages Up. 
Select ‘Image Order’ if required
Select ‘Draw Outlines’ to insert 
borders after each page.

3

 

Select ‘Fit to New Paper 
Size’ - Set any preferred 
paper size or select A4 
(210mm x 297mm) 

4

 

Select [OK] on all open 
windows to print.

You can print a multi-page files into a single print using Multiple-Up 
(from 2 Up to 32 Ups)

Pr
in
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Making a printout with Watermarks 

1 From application, Select 
Printer – [Properties] 

2 At the [Watermarks/Forms] 
tab, select watermark (e.g. 
Confidential, Urgent, etc.) or
Select [New Text] to create 
Select [Edit Watermark] to 
edit any watermark.

3

 

Select [Print on Page 1 
Only] to print watermark 
on first page, if necessary.

4 Select [OK] on all open 
windows to print.

From your application, you can insert watermark. 

Pr
in

t
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Making direct fax from computer

You can perform PC Faxing from your application.

To cancel Fax, go to [Job Status] 
on the machine panel, select the 
fax job – Press [Cancel]

Note

Pr
in

t

1 From application, Select 
Printer – [Properties] 

2 On the [Paper/Output] tab, 
select [Job Type List] – 
Select ‘FAX’ and Click 
‘OK’ on all open windows.

3

 

The ‘Fax Recipient’ 
window displayed. Enter 
recipient name and fax 
number on the text box 
and click [To>>] button. 
(Repeat step to add more than 
one recipient)

4 Select [OK] on all open 
windows to proceed.

3333



1. Lift up the Cover A release lever, and open Cover A. 
2. Remove any paper below the Fuser Unit by carefully pulling up and out. 

If the jammed paper is inside the Fuser Unit, lower the green A2 lever in the direction of     
the arrow to open the Fuser Unit Cover.

3. Close Cover A until the cover latches. 

MAINTENANCEMAINTENANCE

Clearing Paper Jams

Paper Jams in the Document Feeder

1.    Open Document Feeder Cover and remove the jammed document.
2-3. If necessary, turn green wheel to feed out jammed document. 

4.     If a document is jammed underneath the inner guide, open inner guide.
5-6. Turn green wheel to remove the document. Gently close the cover. 

Paper Jam in Cover A

If paper is torn, make sure to remove any 
torn pieces of paper inside the machine.

Note

1 2 3

4 5 6
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Clearing Paper Jams

Paper Jams in Cover B

Paper Jams in Cover C

Paper Jams in Cover D

Pa
pe

r J
am

s

1. Lift up the Cover B release lever located on the paper, right side of the cover, and  
open Cover B.

2. Remove the jammed paper. Close Cover B until the cover latches

1. Lift up the Cover C release lever located on the paper, right side of the cover, and  
open Cover C.

2. Remove the jammed paper. Close Cover C until the cover latches

1. Lift up the Duplex Module Cover D release lever located on the upper, right side of  
the door, and open Cover D. 

2. Remove the jammed paper. Close Cover D until the cover latches

3535
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Clearing Paper Jams

Paper Jams in Cover E

If paper is torn, make sure to remove any 
torn pieces of paper inside the machine.

Note

Paper Jams in Paper Tray 5 (Bypass Tray)

1. Inspect the paper feed entrance in Tray 5 (Bypass Tray),

2. Remove any jammed paper. 

NOTE: When two or more sheets of paper are loaded in the  
tray, remove all of the sheets. 

1. Lift up the release lever located in the upper, right corner of Cover A, and open 
Cover A. 

2. Lift up the release lever located in the upper, right corner of Cover E, and open 
Cover E. Remove the jammed paper. 

3. Close Cover E, and then Cover A. Make sure the covers latch properly. 

3636

Pa
pe

r J
am

s

1 2

1 2



1. Open the Front Cover by pulling the cover towards you. 
2. Pull the Toner Cartridge out until the handle can be lifted on top of the cartridge.
3. Grasp the handle and remove the cartridge from the machine. 

Replacing Toner Cartridge 

1. Remove the new Toner Cartridge from the box. 
2. Before removing the cartridge from the bag, vigorously shake the cartridge side to   

side to loosen the Toner. 
3. Remove the cartridge from the bag. 
4. Place the Toner Cartridge in position, and slide it into the machine until it clicks into 

place. 
5. Close the Front Cover. 

C
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Replacing Consumables

To install new Toner Cartridge

3737
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1. Open the Front Cover by pulling the cover towards you. 
2. Open the Bypass Tray, and 
3. Open Cover A while lifting up the release lever.

Replacing Drum Cartridge

4. Lift up the colored lever, and slide the Drum Cartridge out until the handle on  
top of the cartridge can be lifted. 

5. Grasp the handle and remove the cartridge from the machine. 

Replacing Consumables

To install new Drum Cartridge

1. Remove the new Drum Cartridge from the box. 
2. Carefully remove the protective sheet from the cartridge by peeling the tape 

up and slowly pulling the sheet out. 
3. Place the cartridge in position and slide it into the machine until it clicks into 

place. 
4. Remove the cartridge seal completely by pulling the tape straight out and 

make sure the cartridge remains fully seated to the rear. 
5. Close Cover A until it latches, and then close the Bypass Tray.
6. Close the Front Cover. 
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Replacing Staple Cartridge (Finisher)

1. Open the Finisher Front Door

2. Rotate the Stapling Unit to the right and pull out on the Staple Cartridge handle 

3. Remove the used cartridge

4. Unpack and install the new cartridge. 

5. The cartridge will click into place when it is installed correctly.

6. Insert the cartridge into the machine. Close the Finisher Front Door. 

Replacing Staple Cartridge (Booklet Finisher)

1. Open the Finisher Front Door. 

2. Pull Booklet Maker access  
handles and pull out the Stapling 
Unit.

3. Squeeze the handles and pull 
to remove the used cartridge. 

4. Unpack and install the new 
cartridge. The cartridge will click 
into place when it is installed 
correctly. 

Return the Stapling Unit to its 
original position. 

Close the Finisher Front Door. 

Replacing Consumables3939
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BILLING METER
On the Machine Panel, press <Machine Status> button. 

Select [Billing Meter / Print Report] tab - Select Billing Meter

METER 1 : Total number of Meter 2 + Meter 3 + Meter 4
METER 2 : Total number of copies
METER 3 : Total number of prints
METER 4 : Total number of fax printout

Checking Billing Meter / Supplies Status (Consumables) 

SUPPLIES / CONSUMABLES
On the Machine Panel, press <Machine Status> button. 

Select [Supplies] tab
The status of consumables is shown as: 
“OK”, “Replace Soon (Order Now)”, or “Replace Now”

For toner, the amount is shown in percentage (0 to 100%).

4040



Consumables Part No. 

Customer Replaceable Units Part Number         Qty per box

Toner Cartridge CT200417

 

1 unit

Drum Cartridge

 

CT350299

 

1 unit

Staple Cartridge CWAA0455 

4141



Logon to

 

www.fujixerox.com.my 4242

1

 

Click on [Support] 

2

 

[On-line Support Assistant] : Select Model

3

 

Select FAQ or enter keyword to Search

4 Problem Solved?

 

We need your Feedback!  
Click Yes > I Found My Answer

3

 

Request submitted! 

2

 

[Service & Support Request] : 
Submit Request



This Quick User Guide is printed on FUJI XEROX Office Color Products.
Copyright Reserved © 2010 by Customer Training, Fuji Xerox Malaysia

Printed in Malaysia 

For Service & Supplies Enquiries (Nationwide)

Toll Free : 1-300-88-1163

Online support:  http://onlinesupport.fujixerox.com

The contents described herein are correct as of August, 2010.
Edition 2.1 Pazu
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